CLASSROOM SUPPORT SERVICES (CSS)

CSS has supported classrooms in three geographic locations.

- 209 supported classrooms
- Smallest capacity 20
- Largest capacity 500
- CSS is open for business 17 hours per day.

INTERNET ALERT: ST. VALENTINE'S DAY E-CARD CARRIES STORM WORM VIRUS

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.

Return to top

UNIVERSITY OF NORTH TEXAS™

Network Connection | Link of the Month | IRC News | RSS Matters | Helpdesk FYI | Short Courses | Staff Activities
Computing and Information Technology Center Home | Help Desk | Training | About Us | Publications | Our Mission

Available for RSS/XML syndication. See the list of all available xml/rss feeds.

Questions, comments and corrections for this site: lynch@unt.edu
Site was last updated or revised: February 15, 2008

Originally published, February 2008 -- Please note that information published in Benchmarks Online is likely to degrade over time, especially links to various Websites. To make sure you have the most...
The GroupWise to Microsoft Exchange Migration is progressing well, according to Jason Myre who heads up the group responsible for the migration - the CITC Messaging Systems Group. If you have questions about the migration, a visit to the group's website, http://messaging.unt.edu/, might prove useful. Some highlights of the site are:

- GroupWise to Exchange Migration for Users
- Frequently Asked Questions
- Education
- User Preparation for Migration

When will your area migrate?

The person who knows the most about this topic is your Network Manager. If you are unsure who your Network Manager is, see Network Managers by Major Area or Network Managers by Department. That said, logging on to the Messaging Systems Group website with your EUID and password will allow you access to the SharePoint Migration Calendar click on the link to that and you will be able to see the migrations that are scheduled for the next several months. The first time you attempt to log into the site you may be prompted to login to ntranet.unt.edu\uid. If so just change the ntranet.unt.edu\ to unt\ and then enter your EUID and password. For example: unt\cp10001 Any questions about your area's migration schedule should be directed to your Network Manager.
Managing Your Spam

By Claudia Lynch, Benchmarks Online Editor

The idea of "managing" spam may seem ridiculous at first, but due to the tireless efforts of a number of people in the CITC over a number of years, it really has come to the point that we all need to take an active role in managing what is defined and, perhaps more important now, not defined as "spam" by various systems in place here at UNT.

Spam, an overview

Before we get into the nitty-gritty of managing spam, lets talk about what, exactly, spam is. Spam, for the purposes of this article, is defined as "unsolicited or undesired electronic messages." The wikipedia entry where that definition came from states that there are many types of electronic spam, including:

- E-mail spam, unsolicited e-mail.
- Mobile phone spam, unsolicited text messages.
- Forum spam, posting advertisements or useless posts on a forum.
- Spamdexing, manipulating a search engine to create the illusion of popularity for webpages.
- Spam in blogs, posting random comments or promoting commercial services to blogs, wikis, guestbooks.
- Newsgroup spam, advertisement and forgery on newsgroups.
- Messaging spam ("SPIM"), use of instant messenger services for advertisement or even extortion.

We're only concerned with E-mail spam in this article*.

How can I manage my spam?

First of all make it a habit to check your spam, or junk mail folders every few days. You might be surprised what gets put in there. You also need to check messages quarantined by the UNT anti-spam/anti-virus system, IronPort.

Outlook

The campus is progressing in our move from GroupWise to Microsoft Outlook. If you click on Help at the top of the Outlook screen and then search on Junk the following items (as of 2/14/08) will come up:

Topics in "Junk e-mail"

Overview of the Junk E-mail Filter
GroupWise

Last July we published an article called GroupWise Spam Control Features. Working from that article, if you are having things automatically sent to your trash, you need to make sure and look through your trash before you empty it, just to be sure nothing is being sent there that you really want.

UNT Spam Quarantine

No matter what e-mail system you are using, you will need to check for messages that have been quarantined by the UNT mail host system at least once every two weeks. This is because of the anti-spam/anti-virus software system that was installed last November. To view your quarantined messages, go to http://spam.unt.edu and log in with your EUID and password. If a legitimate e-mail message was quarantined, check the box next to the message and then indicate that the message should be released for delivery by choosing an action - options include Release, Release and add to Safe List, or Delete - from the "Select Action" area and then clicking the Submit button. For example:
If you receive a spam message in your regular inbox, forward it, as an attachment, to spam@access.ironport.com and IronPort will tweak their spam detecting rules to block that kind of message in the future.

More information about using UNT Spam Quarantine can be found by clicking on the word Help in the top left-hand corner of the spam.unt.edu screen and then choosing Online Help after you log-in to spam.unt.edu.

If you want to read up on UNT Spam Quarantine without logging-in, you can visit: https://spam.unt.edu/help/enduser_help.

If you need further information with regard to the UNT E-mail gateway, please contact Bahram Paiani at postmaster@unt.edu.

*By the way, did you know that spam is not new? In fact, spam delivered via the Internet or other electronic means will celebrate its 30th birthday this May. Really. Oh, and the term spam comes from the Monty Python Spam sketch which was first televised in 1970. See Brad Templeton's article Origin of the term "spam" to mean net abuse for further details.

Internet Alert: St. Valentine's Day E-Card Carries Storm Worm Virus

See also: Storm Worm Sends Trouble for Valentine's Day and Google News.

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.

Originally published, February 2008 -- Please note that information published in Benchmarks Online is likely to degrade over time, especially links to various Websites. To make sure you have the most current information on a specific topic, it may be best to search the UNT Website - http://www.unt.edu - You can also search Benchmarks Online - http://www.unt.edu/benchmarks/archives/back.htm as well as consult the UNT Helpdesk - http://www.unt.edu/helpdesk/
Questions and comments should be directed to benchmarks@unt.edu.
More Windows Vista and Microsoft 2007 Server Courseware Added

By Dr. Elizabeth Hinkle-Turner, Student Computing Services Manager

Several new titles have been released and added to the UNT SkillPort site. These titles are generally for technical support with Microsoft Windows Vista and on the latest Microsoft server releases. The new titles are as follows:

Windows Vista Operating System Training

- 70-620 TS: Microsoft Windows Vista Client, Configuring
  - Installing Windows Vista
  - Configure Windows Vista Environments
  - Mentoring 70-620 TS: Configuring Windows Vista Client

Microsoft 2007 Servers: SharePoint, Exchange

- Microsoft Exchange Server 2007: Configuration
  - Preparing the Exchange Server 2007 Infrastructure
  - Installing and Transitioning to Exchange Server 2007
  - Managing Default, Custom, and Public Folders in Exchange Server 2007
  - Connectors, Transport Rules, and Message Compliance in Exchange Server 2007
  - Accessing Exchange Server 2007 Remotely
  - Disaster Recovery with Exchange Server 2007
  - Configuring Outlook 2007 for Exchange Server 2007

As always - if you have any questions or requests regarding computer-based training, contact me at ehinkle@unt.edu. The complete catalog of all UNT computer-based training is found at http://www.unt.edu/cbt/final_new_cbt_training.pdf.

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.
From "Today's Cartoon by Randy Glasbergen", posted with special permission. For many more cartoons, please visit www.glasbergen.com.

© 2007 by Randy Glasbergen.
www.glasbergen.com

“To be understood by another person, one must not authorize validity to the very prospect of invalidation which has the potential to assume its own assumption of deficiency within the very milieu of the message. That is the key to clear and effective communication!”
Don't Forget Our Monthly Columns!

By Claudia Lynch, Benchmarks Online Editor

In addition to our feature articles, Benchmarks Online publishes monthly columns that are focused on specific aspects of computing here at UNT (and beyond, in some cases). Check out what is waiting for you this month:

- **By the Numbers** - Not really a column, but a new feature, giving you a glimpse behind the scenes of the volumes of data, spam, etc. processed, managed, and otherwise handled here at UNT.

- **RSS Matters** - "RSS Matters" is the monthly column written by the Research and Statistical Support Group in Academic Computing Services. Their articles focus on topics of a statistical and/or research methods nature. This month, Patrick McLeod talks about "SPSS: Yesterday, Today and Tomorrow." Check it out!

- **The Network Connection** - "The Network Connection" may well be the longest running column in computer publishing history. Certainly in University of North Texas computer publishing history. This month, Dr. Baczewski ponders the thought that we may soon have "No Reasonable Expectation of Privacy." Click on the Network Connection link above and read all about it.

- **Link of the Month** - As it says on the top of the "Link of the Month" page, "each month we highlight an Internet, USENET Special Interest Group (SIG), or similar mailing list(s) or Website(s)." Lately we have been confining ourselves to featuring UNT specific sites. Click on the link above and check out this month's feature, "Center for Achievement and Livelong Learning."

- **Helpdesk FYI** - A new monthly feature from the CITC Helpdesk. Each month they will tackle a topic that has been of particular interest to callers/visitors to the Helpdesk. This month Jonathan "Mac" Edwards talks about "RSS Feeds in Microsoft Outlook." Check it out!

- **Short Courses** - Every semester, Academic Computing Services (ACS) offers short courses on computer-related topics, many of them having to do with statistical research. This column keeps you up-to-date on what is being offered and when as well as other training opportunities.

Short Courses are in SPSS, SAS, Stata, R & S-Plus and New Technologies for Survey Research are being offered in
February. Also, if you have a group that needs a specific class, it may be possible to arrange a special class just for them. Click on the Short Courses link above for more information.

- **IRC News** - As their Webpage says, "the IRC is an advisory and oversight body created to foster communication and cooperation between and among UNT information resources providers and users." We publish the minutes of the IRC meetings each month, when they are available. **The January 15, 2008 are available this month.**

- **Staff Activities** - This column focuses on new employees, people who are no longer employed at the Computing and Information Technology Center, awards and recognitions and other items of interest featured here.

---

**Please Note:** The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.

---

Originally published, January 2008 -- Please note that information published in *Benchmarks Online* is likely to degrade over time, especially links to various Websites. To make sure you have the most current information on a specific topic, it may be best to search the UNT Website - [http://www.unt.edu](http://www.unt.edu). You can also search *Benchmarks Online* - [http://www.unt.edu/benchmarks/archives/back.htm](http://www.unt.edu/benchmarks/archives/back.htm) as well as consult the UNT Helpdesk - [http://www.unt.edu/helpdesk/](http://www.unt.edu/helpdesk/). Questions and comments should be directed to benchmarks@unt.edu.
By Dr. Philip Baczewski, Director of Academic Computing and User Services

No Reasonable Expectation of Privacy

The Fourth Amendment to the United States Constitution provides U.S. Citizens with a reasonable expectation of privacy, at least within their own homes and in regard to their own effects. However, the argument continues to this day as to what is reasonable and what is unreasonable on the part of governments and other entities. Add the disruptive effect of digital technologies and the arguments can get even more complex.

The interaction of technology and privacy has been visited before. In 1967 the Supreme Court of the U.S. ruled in the case of Katz v. United States that "an enclosed telephone booth is an area where, like a home, . . . a person has a constitutionally protected reasonable expectation of privacy [and] that electronic, as well as physical, intrusion into a place that is in this sense private may constitute a violation of the Fourth Amendment. . . ." The advent of cell phones seems to have made the issue of phone booths obsolete, but the concept of electronic privacy is one that we now take for granted (but perhaps shouldn't.) In fact, in many public places one often can't avoid being privy to what should be private conversations, leaving us to wish that they or we had our own cone of silence.

So, we know we can retreat to a phone booth for privacy, but what about other public places? In 2002, the State of Washington Supreme Court ruled that there was no protection from privates being photographed in public. Since September 11, 2001, there has been much attention to what you can photograph, but there is not much limitation as to who you can photograph. There is no reasonable expectation of privacy in a public place, a fact that keeps paparazzi everywhere gainfully employed. You may not be a celebrity, but is it possible to avoid being photographed? Maybe not. With the proliferation of cell phones and the ability of those phones to be a camera, it is becoming increasingly possible for you to wander into someone's snapshot.

You can prevent someone from taking pictures while they are on your property, however, you can't keep someone from photographing your property from a location that is off your property. Google has turned this fact into a feature with a service they call Street View. In a number of U.S. metropolitan areas, miles of streets on the map have photographs associated with them. These are not just any photographs, but rather 360 degree views from the street showing houses, yards, cars, and any people that happen to be walking by. These photos are stitched together allowing you to virtually drive down a street. Now anyone with your address can see what your house looks like, what the surrounding landmarks are, what kind of car you drive (if you were parked in your driveway), and if your house needs painting. Thank you Google.

It seems that, thanks to the Internet, it's becoming much harder to live a fully anonymous
existence, especially if your work or lifestyle makes you a denizen of the on-line world. Some people expose themselves on sites like Facebook or MySpace. But sometimes professional activity is enough to pull back any cloak of anonymity. For example, this column has appeared on line for at least the last 10 years and has always had my name, title, and e-mail address associated with it. I guess it's too late for me to hide. Even if we didn't maintain archives of this on-line publication, someone else would have. As storage continues to become less expensive, keeping archives of Internet information, as vast as it may be, becomes economically more feasible. Need a copy of the whole Internet? Google undoubtedly has one as well as snapshots going back for years.

There has been a quiet proliferation of live webcams on the Internet. A number of sites either allow you to search for webcams or troll the Internet to randomly find and present them to you. I can sit here in Texas and see who's walking down the street in Rousse, Bulgaria. How long will it be before Google knits those webcams together so that you'll be able to follow someone walking down a street and turn the corner with them to continue your surveillance? Perhaps they can call it "Stalker View." It sounds far fetched, but then so did "Street View" 10 years ago.

It might not be too long before you will have no reasonable expectation of privacy, at least if you live an urban and on-line existence. You can hide in your home, but be sure to draw the curtains lest the Google street-view-mobile comes by. You can hide in the wilderness, but it's only a matter of time -- Google will find you.

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.

Originally published, February 2008 -- Please note that information published in Benchmarks Online is likely to degrade over time, especially links to various Websites. To make sure you have the most current information on a specific topic, it may be best to search the UNT Website - http://www.unt.edu. You can also search Benchmarks Online - http://www.unt.edu/benchmarks/archives/back.htm as well as consult the UNT Helpdesk - http://www.unt.edu/helpdesk/ Questions and comments should be directed to benchmarks@unt.edu

Return to top
Each month we highlight an online mailing list or website. Frequently the link is associated with UNT.

The Center for Achievement and Lifelong Learning is a new center that "combines the resources of the Center for Continuing Education and Conference Management, or CCECM, with aspects of the Professional Development Institute, or PDI." Visit the CALL website - http://www.unt.edu/call/ - and check out their impressive list of resources including Mini-courses and Online courses.

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.

Originally published, February 2008 -- Please note that information published in Benchmarks Online is likely to degrade over time, especially links to various Websites. To make sure you have the most current information on a specific topic, it may be best to search the UNT Website - http://www.unt.edu - You can also search Benchmarks Online - http://www.unt.edu/benchmarks/archives/back.htm as well as consult the UNT Helpdesk - http://www.unt.edu/helpdesk/. Questions and comments should be directed to benchmarks@unt.edu.
RSS feeds allow you to receive news updates from your favorite websites in one convenient place. Microsoft Outlook can act as an RSS reader, and makes it simple to have these feeds sent to your Outlook RSS inbox.

Setting up a new RSS feed is relatively simple. First you should find the link for the RSS you wish to subscribe to. In our example we will subscribe to the main UNT RSS feed, the link for which can be found on UNT’s homepage (http://www.unt.edu). RSS feeds will often have a link that looks similar to this, or simply have RSS set up as a link. Clicking on the RSS link will bring you to another page. Highlight and copy the address located in the address bar, http://web3.unt.edu/news/rss/stories.xml. Open Microsoft Outlook. Click Tools > Account Settings > RSS Feeds > New. Paste the address you just copied into the new window that appears, then click Add. You should now have a new RSS Feed listed inside the RSS Feeds Mail Folder.

Sharing RSS Feeds with Others

Your list of RSS Feeds can be quickly exported into one .opml file so that you can share them with others. On the File menu, click Import and Export, Click Export RSS Feeds to an OPML file, and then click Next. Now select the check boxes for each RSS Feed that you wish to export. Choose a name for your file then click Next. Your file will be saved to your My Documents folder. To import an .opml file someone has sent, go back to the File menu, click Import and Export, click Import RSS Feeds from an OPML file, and then browse for the file you wish to import.

To share a single feed open the feed you wish to share, and click on the Share This Feed icon.

Removing RSS Feeds

There are two options for removing an RSS Feeds. The first option is to delete the RSS Feeds folder you wish to remove from your Mail Folder in the Navigation Pane. This will also remove all of the Feed content. To remove the RSS Feed, but keep all existing content you will need to click on Tools > Account Settings > RSS Feeds. Now click on the Feed you wish to cancel and select Remove.

For additional information on RSS Feeds, Microsoft Outlook has very good documentation in their help files. You may also find more information at
http://en.wikipedia.org/wiki/RSS_(protocol)

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.

Originally published, February 2008 -- Please note that information published in *Benchmarks Online* is likely to degrade over time, especially links to various Websites. To make sure you have the most current information on a specific topic, it may be best to search the UNT Website - http://www.unt.edu. You can also search *Benchmarks Online* - http://www.unt.edu/benchmarks/archives/back.htm as well as consult the UNT Helpdesk - http://www.unt.edu/helpdesk/. Questions and comments should be directed to benchmarks@unt.edu

Return to top
January 15, 2008

VOTING MEMBERS PRESENT: PHILIP TURNER, CHAIR, TIM CHRISTIAN, CLAUDIA LYNCH (for ELIZABETH HINKLE-TURNER), JOHN HOOPER, JIM BYFORD (for SCOTT WINDHAM), GARY MATTHEWS, YUNFEI DU, FRANCES MAY, LOU ANN BRADLEY, WILL SENN, JON NELSON, CENIZ CAPAN, DON GROSE NON-VOTING MEMBERS PRESENT: MAURICE LEATHERBURY, PHILIP BACZEWSKI, JOE ADAMO, SEAN-MIKEL FLOWERS, SUE ELLEN RICHEY (Recording Secretary) MEMBERS ABSENT: NOREEN GOGGIN, BRUCE HUNTER, PATRICK PLUSCHT, JUDITH ADKISON, ROBERT NIMOCKS, JOHN PRICE, RAY BANKS, ABRAHAM JOHN, DONNA KEENER, RAMU MUTHIAH GUESTS PRESENT: CHARLOTTE RUSSELL

Distributed Computing Support Management Team

Philip Baczewski reported for the Distributed Computing Support Management Team that they met on January 4, 2008. The meeting featured a demonstration of the new IT problem reporting service for end users. This simple web interface gathers user and problem information and creates tickets in the Remedy ITSM 7 trouble ticketing system, which are routed to the appropriate support staff. The new system will be rolled out in coordination with the migration to the new ticketing system and will be presented via a web page that will feature searchable or browseable help information as well. Migration is currently slated for early February. DCSMT is next scheduled to meet on January 18.

Student Computing Planning Group

Claudia Lynch reported for the Student Computing Planning Group that the members of the student email committee have been testing Microsoft Live at EDU and Google. Informal questionnaires have been sent out to the lab consultants to gain more input on different email systems and their uses by the students. Other anecdotal evidence continues to be gathered from schools that have already switched to these ‘free email systems’ for their student populations. Susan Williamson of the Alumni Office has been added to the committee to provide input on alumni relations with email from these companies.

An ‘email meeting’ of the tech part of the email committee will occur this week. A formal meeting of the entire committee will be called during the week of January 20 (after MLK Day).

Standards & Policy Planning Group

Tim Christian reported for the Standards & Policy Planning Group that he has received the Email Policy from Bonita Hairston with some suggested minor changes and is working on
New Imaging System, Email Archiving, and Workstation Replacement

Maurice Leatherbury reported that CITC has selected Image Now for the new Imaging system, and plan to kick off that project soon. They need to get Image Now engaged so that they can send a consultant to help with the integration of their product with PeopleSoft. It is hoped that it will be up and running sometime this summer, with the first user being the Registrar’s office, Student Records or Purchasing & Payment Services because they have the heaviest volume of imaging.

At the December meeting, Maurice had asked for advice about purchasing an email archiving software. He reported to the IRC that CITC went ahead and purchased the archiving software, and got a $25,000 or $30,000 price break, but does not plan to roll it out until they are farther along on the Microsoft Exchange migration. Maurice has attempted to contact the new UNT Compliance Officer to try and meet to get an idea of what his preferences are related to archiving. Cengiz Capan asked if there would be a need to purchase any additional equipment/software for this purpose in the future. Maurice replied that he was not aware of anything else they would need.

Maurice distributed a proposal for a plan for mandatory workstation replacement. He explained that the State requires UNT to have a desktop replacement schedule and up to now he has been pointing to a very old replacement plan that has been on the books. When he began looking at data about the age of the micro-computers on campus, it became clear that there are a lot of very old machines on campus. Maurice’s proposed plan would provide a mandatory replacement of primary workstations, for “knowledge workers,” on a cycle of 4 years, which would have an average annual cost of roughly $1,188,300. The numbers of “knowledge workers” at UNT were determined by Human Resources, based on their definition of that group. This number would not include maintenance, housekeeping, food service employees, etc. Maurice stated that he is aware that this plan may disadvantage some departments who have already planned funds for this purpose. Further, this plan would not address lab machines. He has discussed this with VP Andrew Harris and further planning will be needed to possibly merge an existing plan to replace faculty machines every three years. Discussion followed during which Jon Nelson noted that the College of Music faculty really do not have a need for the newest desktop computer since they only use their computers for email, and might prefer to use their HEAF funds to purchase musical instruments instead. Jon recommended that departments be allowed to decide which machines to replace. Maurice welcomed all comments and asked members to send further comments to him by email, and all will be considered when preparing the final plan. He also suggested that a sub-committee be formed to discuss and work through some of the issues and asked for volunteers, with Gary Matthews, Tim Christian, Cengiz Capan, and Philip Baczewski being the first to agree to serve. Cengiz suggested that Donna Asher be invited to serve on this committee also.

Proposal for restructuring the Advisory Committees to Information Technology at UNT

Maurice Leatherbury distributed a proposal for restructuring the Advisory Committees to Information Technology at UNT. He explained that there is a need to re-establish the Information Resources Steering Committee. He also wants to see this council restructured to make it more effectual. The most controversial thing in the proposal is the suggestion to not have network managers as members of the IRC. He believes their needs can be addressed through the Distributed Computing Support Management Team, and they can
serve on the various advisory groups. Philip Baczewski noted that there should not be an exclusion of DCSMT members serving on the IRC. In the discussion that followed, there were a number of suggestions put forth, which Maurice said he would take into account. Maurice stated that the next action will be to write a policy and bring it to the IRC, so he invited more comments and suggestions to be emailed to him prior to the next IRC meeting.

Since there was not a quorum present, the minutes of the December 18th IRC meeting will be reviewed at the February meeting.

There being no further business, the meeting was adjourned at 3:20 pm.

* For a list of IRC Regular and Ex-officio Members click here.

**DCSMT Minutes can be found here.

IRC Meeting Schedule

The IRC generally meets on the third Tuesday of each month, from 2-4 p.m., in the Administration Building Board Room. From time to time there are planned exceptions to this schedule. The schedule can be found here. All meetings of the IRC, its program groups, and other committees, are open to all faculty, staff, and students.

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.

Originally published, February 2008 -- Please note that information published in Benchmarks Online is likely to degrade over time, especially links to various Websites. To make sure you have the most current information on a specific topic, it may be best to search the UNT Website - http://www.unt.edu. You can also search Benchmarks Online - http://www.unt.edu/benchmarks/archives/back.htm as well as consult the UNT Helpdesk - http://www.unt.edu/helpdesk/ Questions and comments should be directed to benchmarks@unt.edu
SPSS: Yesterday, Today and Tomorrow

By Patrick McLeod, Research and Statistical Support Services Consultant

As many of the members of our university community know, there have been some recent changes in support for SPSS for Windows at the University of North Texas. How did we get here? Where are we now? Where are we going? I hope to answer all these questions (and more!) in the following article, available exclusively at Benchmarks Online.

How did we get here?

SPSS has a long history at UNT, as it does at many institutions of higher education. Before my time in Academic Computing Services, SPSS was run from the academic mainframe. As mainframe terminals gave way to desktop computers, SPSS was also provided as a desktop application. In my time in Academic Computing Services, we've seen SPSS versions 11.5, 12, 13, 14, 15 and 16 for Windows and SPSS versions 13 and 16 for Mac. Until the middle of last year, we were receiving requests for support for all of those versions of SPSS and we were handling them as best we could with a high degree of success.

What changed?

The short story is that SPSS changed their support policy to move more or less in unison with the current version of SPSS for Windows and SPSS for Mac. This current SPSS support policy offers active support for the most current version of SPSS and the version immediately prior to the most current version. In the case of SPSS for Windows, the most current version is SPSS 16, so the currently supported versions of SPSS for Windows are SPSS 16 and SPSS 15. In the case of SPSS for Mac, the most current version is SPSS 16, so the currently supported versions of SPSS for Mac are SPSS 16 and SPSS 13. Note here that the Mac versions do not follow the same released pattern as the Windows versions; SPSS 13 for Mac was the prior release to SPSS 16 for Mac. SPSS 13 for Mac only worked with PowerPC based Macs, not with Intel based Macs. SPSS 16 for Mac works with both types of processors.
Where are we now?

The SPSS support policy leaves us in a bit of a pickle here at UNT. We have a substantial number of SPSS 14 for Windows local installations (installations that are licensed locally on the machine) and network installations (installations that are licensed from our ACS license server). As of April 1, 2008, SPSS will discontinue all support of SPSS 14. We do not feel that this will be a significant issue for support for SPSS 14 at UNT because we have the most current possible authorization codes (for individual installations) and the most current possible license code running on our license server. Both of these codes will license SPSS through the end of May 2008. We currently have both SPSS 15 for Windows and SPSS 16 for Windows available for local installations and SPSS 15 for Windows is available to be licensed from our ACS license server as a network installation.

What’s next?

The most immediate change is that everyone will need to make plans to migrate to either SPSS 15 for Windows or SPSS 16 for Windows on or before the end of May 2008. My preference would be to get everyone from network managers to lab managers to professors up to SPSS 16 for Windows by the end of May 2008. Bringing everyone up to SPSS 16 would greatly streamline our SPSS support workload, but more importantly for all of us, it will give the campus research and instruction communities the greatest amount of time between May 2008 and when we will need to upgrade again whereas upgrading to SPSS 15 will not provide as much “stable production” time since it is the prior version being supported instead of the current version being supported.

I know that this is a lot easier to write about than to plan and implement. I will be beginning communication with Network Managers via the NETMAN email list later this month to gather information and begin establishing a plan for getting all of us up to SPSS 16 in as orderly and timely a manner as possible.

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.

Originally published, February 2008 -- Please note that information published in Benchmarks Online is likely to degrade over time, especially links to various Websites. To make sure you have the most current information on a specific topic, it may be best to search the UNT Website - http://www.unt.edu - You can also search Benchmarks Online - http://www.unt.edu/benchmarks/archives/back.htm as well as consult the UNT Helpdesk - http://www.unt.edu/helpdesk/

Questions and comments should be directed to benchmarks@unt.edu
By Claudia Lynch, Benchmarks Online Editor

Short Courses are in SPSS, SAS, Stata, R & S-Plus and New Technologies for Survey Research are being offered in February. Surf over to the Short Courses page to see the schedules. If you have a group that needs a specific class, it may be possible to arrange a special class just for them. See "Customized Short Courses" below for further information.

Customized Short Courses

Faculty members can request customized short courses geared to their class needs from ACS. Other groups can request special courses also. Contact ACS for more information (ISB 119, 565-4068, lynch@unt.edu).

Especially for Faculty and Staff Members

In addition to the ACS Short Courses, which are available to students, faculty and staff, staff and faculty members can take courses offered through the Human Resources Department, and the Center for Distributed Learning. Additionally, the Center for Achievement and Lifelong Learning offers a variety of courses, usually for a small fee.

EIS training is available. Questions or comments relating to EIS training should be sent to the EISTRN GroupWise account.

Moving from GroupWise to Microsoft Outlook Training

Although the project has been delayed, a useful source for finding resources for preparing the campus community for this transition can be found here.

Central Web Support

Consult Central Web Support for assistance in acquiring “Internet services and support.” As described on their website:

Services include allocating and assisting departments, campus organizations and faculty with web space and associated applications. Additionally, CWS assists web developers with databases and associated web applications, troubleshooting problems, support and service.

In addition the Central Web Support office provides training to faculty and staff for web development. Training courses that are offered include
Dreamweaver, Fireworks, Integrating Dreamweaver and Fireworks, ColdFusion, Zope and SQL.

In an effort to provide the services that the UNT Web Development [requires] our staff will continually add additional courses to fit the needs of our faculty, staff and students.

Center for Distributed Learning

The Center for Distributed Learning offers courses especially for Faculty Members. A list of topics and further information can be found [here](http://www.unt.edu/benchmarks/archives/2008/february08/short.htm).

The center also offers a "Brown Bag" series which meets for lunch the first Thursday of each month at Noon in Chilton 245. The purpose of this group is to bring faculty members together to share their experiences with distributed learning. One demonstration will be made at each meeting by a faculty member with experience in distributed learning. More information on these activities can be found at the Center for Distributed Learning Website.

UNT Mini-Courses

There are a variety of courses offered, for a fee, to UNT faculty, staff and students as well as the general public. For additional information surf over to [http://www.unt.edu/minicourses/](http://www.unt.edu/minicourses/)

Information Security Awareness

- Wednesday, February 20 2-3:30 p.m. ESSC Room 152
- Thursday, March 20 2-3:30 p.m. ESSC Room 152

The UNT Information Security team is currently offering Information Security Awareness courses to all UNT faculty and staff. Topics to be covered will include workstation security, sensitive data handling, copyright infringement issues, identity theft, email security, and more. For more information, or if you would like to request a customized course to be taught for your department, contact Gabe Marshall at x4062, or at security@unt.edu.

Alternate Forms of Training

Many of the General Access Labs around campus have tutorials installed on their computers. See [http://www.gal.unt.edu/](http://www.gal.unt.edu/) for a list of labs and their locations. The Willis Library, for example, has a list of Tutorials and Software Support.

The Training Website has all sorts of information about alternate forms of training. Computer Based Training (CBT) and Web-based training are some of the alternatives offered.

For further information on CBT at UNT, see the CBT website. Note, also, some Benchmarks Online articles that have been published this month, and in the
recent past:

- More Windows Vista and Microsoft 2007 Server Courseware Added
- SkillPort Training Site Update
- Free and Legal: Copyright Advice and Training Online
- The Gift that Keeps on Giving: Even More Outlook and Office 2007 Training Posted on the CBT Website
- New Titles Added in SharePoint Server 2007, Publisher, Project, and Office 2007

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an email, please contact UNT Information Security at (940) 369-7800.
Transitions

New Employees:

- Elliot Kidd, Data Communications Field Technician (part-time)
- April Cavins, Data Communications Field Technician (part-time)
- Christopher Sipriano, Data Communications Field Technician (part-time)

No longer working in the Computing and Information Technology Center:

- Abdulkader Bhanpurawala, Student Assistant, Payroll/HR Systems, Finance & Administration Systems (AIS) (part-time).

Changes, Awards, Recognition, Publications, etc.

- DaMiri Young, Student Check-in Developer, Student Computing Services (part-time) has moved to a full-time position of Computer Systems Manager in the Research Computing Support area of Academic Computing and User Services.

Congratulations to ...

- Rebecca Padia, Computer Support Specialist, EIS Security Administration – won a pair of tickets to the Betty Buckley lecture by participating in the InHouse FunFact contest.
- Frank Arnold, Programmer, Fiscal Systems - was recognized as a Soaring Eagle in the February/March 2008 issue HR Connections, the Human Resources Newsletter.

Please Note: The University of North Texas will never ask for personal information by e-mail. If you receive an e-mail purporting to be from the University that asks for personal information or account passwords, do not respond. If there is any question regarding the authenticity of an
email, please contact UNT Information Security at (940) 369-7800.

Originally published, February 2008 -- Please note that information published in Benchmarks Online is likely to degrade over time, especially links to various Websites. To make sure you have the most current information on a specific topic, it may be best to search the UNT Website - http://www.unt.edu. You can also search Benchmarks Online - http://www.unt.edu/benchmarks/archives/back.htm as well as consult the UNT Helpdesk - http://www.unt.edu/helpdesk/

Questions and comments should be directed to benchmarks@unt.edu

Return to top